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General Instructions
To use "Treasures of Russia" you click buttons, pictures, and highlighted text.
As a rule your mouse pointer changes from the arrow to the pointing hand when it is 
over a place that you can click    (a hot spot). The only exceptions are the Toolbox 
buttons and    the System menu.
There can be text hot spots (a word or phrase) and picture hot spots (a picture or part 
of a picture). Text hot spots are usually displayed in a different color than the 
surrounding text (see Book Mode).
Clicking hot spots can bring up pop-up windows. Pop-ups are displayed over other 
windows. To remove the pop-up, click anywhere outside of the pop-up or press the 
ESC key.
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System menu
After starting "Treasures of Russia" the system menu is not visible. To see it click the 
System Menu button in the Toolbox.
"Treasures of Russia" system menu contains the following menu items:

File
Edit
Bookmark
Language
Help

The File menu contains these commands:
- Print Topic - prints the displayed topic (assuming you have a printer installed and 

turned on).
- Print Setup - displays a dialog box in which you can change printer settings 

before printing.
- Exit - closes "Treasures of Russia".

The Edit menu contains these commands:
- Copy - places a copy of the displayed topic in a dialog box where you can select 

text to copy to the Clipboard.
- Annotate - displays a dialog box in which you can attach your own notes to the 

current topic. After annotating a topic, you will see a paper clip icon to the left of the 
topic heading. To view an annotation click the paper clip icon.
The Bookmark menu contains these commands:

- Define - displays a dialog box in which you can add a bookmark to the current 
topic or delete an existing bookmark. After placing a bookmark at a topic, you can 
quickly display that topic from the Bookmark menu.

- More - appears only when more than nine bookmarks have been added to the 
Bookmark menu. Displays a dialog box in which you can select a bookmark.
The Language menu contains these commands:

- English - starts English version of "Treasures of Russia"
- Russian - starts Russian version of "Treasures of Russia"

The Help menu contains the following items:
- Contents
- About Authors
- About Viewer
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Main Menu
The Main Menu consists of six pictures presenting six main modes of the program:

Music & Arts
Book
Topics
Video Clips
Maps
Time Line

By clicking the appropriate picture you will invoke the desired mode.
When you first enter the Main Menu there is a Toolbox icon in the left bottom part of 
the screen. Toolbox buttons are necessary for you for navigating in the title. We 
recommend you to open the icon by clicking twice.
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Toolbox
On the bottom left part of the screen there is the Toolbox icon. It can be opened by 
clicking twice.
The Toolbox consists of fourteen buttons:

Book - jumping to the Book mode contents.

Map - jumping to    the Map mode.

Topics - jumping to    the Topics mode.

Time Line - jumping to the Time Line mode.

Previous - displaying the previous topic in the series (if any).

Next - displaying the next topic in the series (if any).

Back - retracing previous steps backwards.

History - displaying a list of the last 40 topics you have viewed. Double-click any topic title to
redisplay the topic.

Search by keywords - searching chapters by a keyword. This command displays the list of 
keywords. You can select a word from the list, and then display a chapter that contains 
information related to that word.

Full-Text Search - searching chapters containing a particular word or combination of words. 
This feature not only takes you to the topic found, but highlights the word or words found by 



the search. You can use search operators such as AND, OR, NOT and NEAR to further narrow 
your search.

Up - jumping to the higher topic in the hierarchy (if any).

Main Menu - jumping to the Main menu.

System Menu - turning on/off the System menu.

Help - displaying the Help.
If you don't want to see the opened Toolbox you can close it by clicking twice to the blue 
caption of the Toolbox.

If you want to move the Toolbox you can do it by positioning the pointer on the 
Toolbox caption, pressing the left mouse's button, moving the Toolbox to the desired 
place and releasing the mouse button.
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Links Window
After clicking small images in different modes the Links window will appear on the 
screen. This window contains a small image (by clicking the small image you jump to 
the Full Image Mode) and the four buttons:

Book
By clicking the Book button you go to the chapter of the Book Mode related to the small 
image.

Map
By clicking the Map button you go to the map related to the small image.

Time Line
By clicking the Time Line button you go to the time line screen related to the current image.

Topic
By clicking the Topic button you go to the Topics Mode screen related to the current image.
The pointer doesn't change to the pointing hand when it is over an inactive button.

See Also
Toolbox
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Music & Art Mode
The menu of this mode consists of the six pictures representing six music works which
are accompanied by images.
By clicking the appropriate picture you will open the desired music work. After 
finishing music the mode's menu appears.
To stop the music and to return to the Music & Art mode's menu you should press any 
button.

See Also
Book Mode
Topics Mode
Video Clips Mode
Map Mode
Time Line Mode
Toolbox
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Book Mode Contents
After entering the Book Mode from the Main Menu or by pressing Book button in the 
ToolBox the Book Mode Contents screen appears. It consists of six images, where each
image represents a part of the book, with main parts in the upper row: Ancient 
Russian Art, 18th Century Art, 19th and early 20th Century Art; and auxiliary parts in 
the lower    row: Images, Artists, Index. 
After clicking these images the contents of the corresponding part of the book appear.
Contents of the main parts of the book are organized in a single browse sequence. So 
you can browse all main text contents using Previous and Next buttons of the Toolbox.
In all parts of the book the screen consists of two panels: text panel and illustration 
panel.
For instructions about working with main parts of the book see Book Mode.
When you invoke Images time periods appear on the illustration panel. After clicking 
any time period the list of corresponding art works displays on the text panel. To see 
an art work in the Full Image Mode you must click the appropriate line in the list.
When you invoke Artists the alphabet appears on the illustration panel and the list of 
artists in alphabetical order - on the text panel. After clicking any letter in the      
alphabet the list of the artists whose names begin with the letter displays on the text 
panel. To display an article about an artist you must click the appropriate name in the 
list.
When you invoke Index the alphabet appears on the illustration panel and the list of 
keywords in alphabetical order - on the text panel. Clicking any letter in the      
alphabet displays the list of the keywords beginning with the letter on the text panel. 
The result of clicking a keyword depends on the type of reference (see Book Mode).
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Book Mode
In the Book Mode the screen consists of two panels: the text panel and the illustration 
panel.
There can be three types of hot spots in the text panel:
 - dark yellow reference is the image reference and it is used for invoking a new 
illustration image to the screen;
 - green dot underlined reference is the reference to a text in a pop-up window. It's 
displayed over the current window. To remove the pop-up window click anywhere 
outside of the pop-up or press the ESC key;
- dark red reference is the reference to another chapter accompanied by illustration.
After clicking an image (if it is active) on the illustration panel the Links window 
appears.
All chapters of the main text describing art works are organized in a single browse 
sequence. So you can browse all these chapters using Previous and Next buttons of 
the Toolbox.
While reading chapters of the main text use Up button of the Toolbox for jumping to 
the appropriate contents.
Contents of the main parts of the book are organized in a single browse sequence. So 
you can browse all main text contents using Previous and Next buttons of the Toolbox.

See Also
Book Mode Contents
Music & Art Mode
Topics Mode
Video Clips Mode
Map Mode
Time Line Mode
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Topics Mode
In this mode all program images are divided by pictorial type into six broad 
categories, each of which is then subdivided.
You can browse all screens with the same level of the hierarchy using Previous and 
Next buttons of the Toolbox. Use Up button of the Toolbox for jumping to the higher 
level of the hierarchy.
After clicking any small images in the lowest level of the hierarchy the Links window 
appears. To close the Links Window click anywhere outside it.

See Also
Music & Art Mode
Book Mode
Video Clips Mode
Map Mode
Time Line Mode
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Video Clips Mode
The menu of this mode consists of    five pictures representing five video clips. By 
clicking the appropriate picture you will open the desired video clip. After finishing the
video clip click Back button in the Toolbox to return to the mode's menu.
To control a video clip you can use the multimedia controller:

You can use the controller's pointer to restart the video clip at any point.
The right controller's button is used for restarting the video clip if it is currently stopped or 
paused, or pausing the video clip if it is currently playing.

The left controller's button is used for stopping playback of the video clip.

See Also
Music & Art Mode
Book Mode
Topics Mode
Map Mode
Time Line Mode
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Map Mode
There are three types of icons on the maps: Persons, Arts and Events. The active icons
are those on which the mouse pointer changes to the pointing hand.
There is the centuries' line on the bottom of the screen. Clicking any centuries' 
number displays the appropriate map. All maps are organized in a single browse 
sequence. So you can browse all maps using Previous and Next buttons of the 
Toolbox.
By clicking any active person's icon you open a list of persons. Clicking any line in the 
list displays an article about the appropriate person.
By clicking any active art's icon you open the Links window.
By clicking any active event's icon you open a list of events. Clicking any line in the 
list displays an article about the event.
To close any window click anywhere outside it.

See Also
Music & Art Mode
Book Mode
Topics Mode
Video Clips Mode
Time Line Mode
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Time Line Mode
There are three rows of small images on the screen in this mode: Arts, People, Events.
There is the centuries' line on the top of the screen. Clicking of any centuries' number 
displays time line screen for the appropriate century. All time line screens are 
organized in a single browse sequence. So you can browse time line screens using 
Previous and Next buttons of the Toolbox.
By clicking an arts image you open the links window.
By clicking a person's or an events' image you invoke to the screen the appropriate 
information.
To close any window click anywhere outside it.

See Also
Music & Art Mode
Topics Mode
Video Clips Mode
Map Mode
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Full Image Mode
Full screen images are displayed in this mode. All full screen images are organized in 
a browse sequence corresponding with    Images part of the book . So you can browse 
all full screen images using Previous and Next buttons of the Toolbox.
There are additional buttons on the left side of the screen:

Lens - enlarge any detail of the current image. After clicking the button position the pointer 
on the lens's handle, press the left mouse's button and move the lens on the desired part of 
the image. After releasing the mouse button the part of the image into the lens enlarges 
approximately two times.

Zoom - enlarges the current image approximately two times. To move the image click the 
appropriate button of the block. To stop the moving click anywhere. To return from the zoom 
mode click the central button of the block.

Info - displays full title of the current image.

Only Image - removes all but the image from the screen.

Speech - plays the audio record of the title of the current image.

Book - go to the chapter of the book related to the current image.

Map - go to the map related to the current image.

Time Line - go to the time line screen related to the current image.

Topics Mode - go to the Topics Mode screen related to the current image.



Objects -    in some images there is additional information about objects of the image and 
some fragments of the image can exist as independent images. The pointer changes from 
the arrow to the feather when it is over a place with additional information and it changes to 
the catching hand when it is over a fragment existing as independent image.

You can open these fragments or receive additional information by clicking the 
appropriate parts of the image.
Click this button to see where are such fragments and places with additional 
information.

Music    - playing music while you see the image. After clicking the button the list of musical 
works appears. To play the desired music click on the appropriate line of the list. To stop the 
music click anywhere.
The pointer doesn't change to the pointing hand when it is over an inactive button.

See Also
Music & Art Mode
Video Clips Mode




